
Q.1 The estimated rate of unemployment for the year 2018–19 in urban areas was
_______%.

Ans 1. 7.7

2. 5.2

3. 6.8

4. 9

Q.2 Tamper Protection is a feature that prevents unauthorised apps from changing your
security settings. Which of the following Operating Systems supports the same?

Ans 1. Windows 10

2. Windows XP

3. Linux

4. Windows Vista

Q.3 Which of the following forces does NOT conserve mechanical energy?

Ans 1. Gravitational force

2. Frictional force

3. Spring force

4. Electrostatic force

Q.4 In an isosceles triangle, the vertex angle measures 132°. What is the measure of each of
the base angles?

Ans 1. 11° and 8°

2. 24° and 24°

3. 27° and 21°

4. 4° and 10°

Q.5 Select the most appropriate option to fill in the blank.
Intel 8051 microcontroller has _____ 16-bit timer/counter registers.

Ans 1. three

2. one

3. two

4. four
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Q.6 When multiplying 3.24 by 0.006, how many significant figures should the result have?

Ans 1. 2

2. 3

3. 1

4. 4

Q.7 A 5 kg object is pushed with a constant horizontal force of 20 N across a rough surface
with a coefficient of kinetic friction μk= 0.2 for a distance of 10 m. What is the net work
done on the object? (Given: acceleration due to gravity g = 10 m/s²)

Ans 1. 60 J

2. 160 J

3. 100 J

4. 120 J

Q.8 Identify the correct order of steps to configure your web browser.

I. Enable cookies in your web browser
II. Enable scripts to disable or replace context menus (Mozilla Firefox only)
III. Enable file download on IE 11 running on Windows 2012
IV. Enable JavaScript for your web browser

Ans 1. IV, III, II, I '

2. III, II, IV, I

3. IV, I, III, II

4. I, II, III, IV

Q.9 What is the full form of PCB?

Ans 1. Picture Circuit Board

2. Printed Circuit Board

3. Printed Control Board

4. Picture Control Board

Q.10 The distance of the point P(2, 3) from the x-axis is

Ans 1. 1

2. 3

3. 5

4. 2

Q.11 The most common topologies used in LAN networks are _____________.

Ans 1. bus, ring, and star

2. mesh and ring only

3. wired, wireless, and virtual

4. insider threats, LAN sockets, viruses and malware

Q.12 An open water drum is in the form of a cylinder. The height of the drum is 79 m and its
internal diameter is 78 m. Find the area (in m2, rounded off to one decimal place) that

needs to be painted if one wants to paint the inside of the drum.

Ans 1. 24130.8

2. 24155.7

3. 24126.7

4. 24146.6
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Q.13 If the voltage across a conductor is doubled while keeping the resistance constant,
what happens to the current through the conductor?

Ans 1. It doubles

2. It remains constant

3. It increases four times

4. It halves

Q.14 What is the purpose of the 'grep' command in the Linux operating system?

Ans 1. To rename files

2. To display the calendar

3. To display system processes

4. To search for a specific pattern in a file

Q.15 The p-type material is formed by doping a pure germanium or silicon crystal with
impurity atoms having _____ valence electrons. The element most frequently used for
this purpose is _______.

Ans 1. three; gallium

2. five; antimony

3. five; arsenic

4. three; phosphorus

Q.16 What should come in place of the question mark (?) in the given series?

901 903 ? 913 921 931

Ans 1. 909

2. 906

3. 907

4. 905

Q.17

Ans
1. 

2. 

3. 

4. 

Q.18 Which rule is commonly used to determine the direction of the induced EMF in a
conductor moving in a magnetic field?

Ans 1. Ampere's Law

2. Fleming's Left-Hand Rule

3. Lenz's Law

4. Fleming's Right-Hand Rule
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Q.19 Which Article of the Indian Constitution provides that the state shall take steps, to
secure the participation of workers in the management of industry?

Ans 1. Article 45B

2. Article 44C

3. Article 42A

4. Article 43A

Q.20 The quality factor Q of a series RLC circuit at resonance is a measure of the
______________.

Ans 1. total impedance of the circuit

2. energy stored in the circuit

3. resonance frequency

4. rate of energy loss relative to energy stored

Q.21 In SI units, what is the unit of angular momentum?

Ans 1. kg m2 s−1

2. kg m−1 s

3. kg m2 s−2

4. kg m s−1

Q.22 Match the word templates from group A with their types in group B.

Group A Group B
I. Planners and trackers A. Questionnaire
II. Marketing assets B. Flyers
III. Surveys C. Planning sheets

Ans 1. I-A, II-C, III-B

2. I-A, II-B, III-C

3. I-B, II-C, III-A

4. I-C, II-B, III-A

Q.23 In the following number-pairs, the second number is obtained by applying certain
mathematical operations to the first number. Which numbers should replace X and Y so
that the pattern followed by the two numbers on the left side of :: is same as that on the
right side of ::?

(NOTE: Operations should be performed on the whole numbers, without breaking down
the numbers into their constituent digits. E.g. 13 – Operations on 13 such as
adding/subtracting/multiplying to 13 can be performed. Breaking down 13 into 1 and 3
and then performing mathematical operations on 1 and 3 is not allowed.)

X : 16.2 :: 23 : Y

Ans 1. X=19, Y=22.2

2. X=17, Y=22.2

3. X=19, Y=21.2

4. X=17, Y=21.2

Q.24 In microprocessor 8085, which of the following is a 16-bit register?

Ans 1. Z register

2. W register

3. Flag register

4. Stack pointer
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Q.25 Which of the following statements is correct for p-n junction diode?

Ans 1. There is less barrier potential at higher junction temperature.

2. There is no relation between barrier potential and junction temperature.

3. When diode is conducting, junction temperature is lower than ambient temperature.

4. There is higher barrier potential at higher junction temperature.

Q.26 What is the purpose of the 'Subject line' in an email?

Ans 1. To include attachments with the email

2. To provide a detailed explanation of the email content

3. To give a brief summary of the email's topic

4. To list the recipients of the email

Q.27 The odds against an event is 7 : 4 and the odds in favour of another event is 8 : 5. If
both the events are independent, then the probability that at least one of the event will
happen is:

Ans
1. 

2. 

3. 

4. 

Q.28 What does the clock speed of a CPU measure?

Ans 1. The temperature of the CPU

2. The amount of cache memory

3. The number of instructions executed per second

4. The amount of data processed per second
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Q.29 Study the given pie-chart and answer the question that follows.

Monthly percentage expenditure of a Sultan is given in the pie-chart.

What is the monthly expenditure on Food by the Sultan (in ₹) if the total monthly
expenditure of the Sultan is ₹10,000?

Ans 1. 2000

2. 7700

3. 2500

4. 1700

Q.30 Which of the following statements about the accuracy or precision of electronic
instruments is correct?

Ans 1. The precision is the degree to which the repeated measurement gives the same result.

2. The accuracy and precision are the degree to which the measurement gives the same value.
           

3. The accuracy of the measurement is getting the same value for respective measurements.

4. The precision is the degree to which the repeated measurement gives quoted value.

Q.31 UDVA is related to CLDI in a certain way based on the English alphabetical order. In the
same way, AJBG is related to IRJO. To which of the following options is YHZE related,
following the same logic?

Ans 1. GPHM

2. GTFY

3. GHYT

4. GBHY

Q.32 If you need to attach a large file that exceeds the email provider's limit, what is a
common solution?

Ans 1. Reduce the file's resolution.

2. Break the file into smaller parts and send multiple emails.

3. Use a cloud storage service and share the link.

4. Compress the file into a .zip format.

Q.33 The value of

Ans 1. 6.96

2. 11.42

3. 9.2

4. 8.82
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Q.34 Which feature is commonly found in modern anti-virus software to help with real-time
threat detection?

Ans 1. Manual updates

2. Cloud-based detection

3. Offline scanning

4. Passive scanning

Q.35 The product of two consecutive positive integers is 277. If the smaller of these two
integers is represented by x, which of the options below will correspond to the
equation for finding out the value of x?

Ans 1. x2 + x + 277 = 0

2. x2 - x + 277 = 0

3. x2 - x - 277 = 0

4. x2 + x - 277 = 0

Q.36 Which SI base unit is directly derived from the definition of ampere?

Ans 1. Watt

2. Volt

3. Ohm

4. Coulomb

Q.37 If 16th and 20th terms of an A.P. be 385 and 441 respectively, then its 90th term is:

Ans 1. 1419

2. 1423

3. 1421

4. 1420

Q.38 M, S, A, F, J, H and D are seven family members living in the same apartment. M is S’s
husband. H is J’s wife. S is the mother of J and daughter of A. D is the brother of H. F is
the wife of A. How is D related to J?

Ans 1. Wife’s brother

2. Father

3. Husband

4. Brother

Q.39

Ans 1. 88

2. 49

3. 40

4. 69

Q.40 Read the given statement and conclusions carefully and decide which of the given
conclusions follow(s) from the statement.
Statement:
Book-reading is a very healthy habit because it keeps our learning process alive even
after our college or school education.
Conclusions:
I. Nowadays, e-books are gaining far more popularity than hardcovers.
II. Students gain a lot of knowledge and improve language by keeping the habit of
book-reading alive.

Ans 1. Only conclusion I follows

2. Neither conclusion I nor II follows

3. Only conclusion II follows

4. Both the conclusions follow
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Q.41 By which of the following Acts did the rule of the East India
Company end in India, and the rule of the crown begin?

Ans 1. Government of India Act of 1858

2. Regulating Act of 1813

3. Pitt’s India Act of 1784

4. Government of India Act of 1853

Q.42 The derived unit for electrical conductance, the Siemens (S), can be expressed in terms
of SI base units as _________.

Ans 1. kg⁻¹⋅m⁻²⋅s³⋅A²

2. kg⋅m²⋅s⁻³⋅A⁻¹

3. kg⋅m²⋅s⁻³⋅A⁻²

4. kg⁻¹⋅m²⋅s³⋅A²

Q.43 In a certain code language,
‘R + S’ means ‘R is the mother of S’,
‘R @ S’ means ‘R is the husband of S’,
‘R # S’ means ‘R is the sister of S’ and
‘R % S’ means ‘R is the father of S’.
How is N related to P if ‘M # N + O % P @ Q # T’?

Ans 1. Father’s sister

2. Mother

3. Sister

4. Father’s mother

Q.44 In this question, a question is followed by two statements numbered (I) and (II). You
have to decide whether the data provided in the statements are sufficient to answer the
question. Read both the statements and decide the appropriate answer.
Question: A, B, C, D and E are sitting around a circular table facing the centre. Who sits
to the immediate right of A?
Statement (I): Only one person sits between D and C. E sits to the immediate right of D.
Statement (II): B sits to the immediate left of D. Only one person sits between B and E.
Only one person sits between E and C.

Ans 1. Data in statements I and II together are sufficient to answer the question.

2. Data in Statement I alone is sufficient to answer the question while data in statement II is not.

3. Data in statements I and II together are NOT sufficient to answer the question.

4. Data in Statement II alone is sufficient to answer the question while data in statement I is not.

Q.45

Ans 1. 30°

2. 90°

3. 60°

4. 45°

Q.46 What is the role of chemically inactive gases in a light bulb?

Ans 1. To cool the filament

2. To reduce the bulb's light output

3. To prolong the life of the filament

4. To increase the filament's temperature
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Q.47 Who has been honoured with the Goldman Environmental Prize 2024?

Ans 1. Jadav Payeng

2. Alok Shukla

3. Maneka Gandhi

4. Medha Patkar

Q.48 Which of the following statements correctly describes the static characteristics of
transistors in common emitter configuration?

Ans
1.   

           

2.  
            

3.  

           

4. 
           

Q.49 When dividing 0.00456 by 0.12, how many significant figures should the result be
reported with?

Ans 1. 1

2. 2

3. 3

4. 4

Q.50 The mean and the standard deviation of 25 observations were given as 42 and 5,
respectively. Later it was found that one of the observations was incorrectly entered as
10, when its correct value was 210. What would have been the correct standard
deviation?

Ans 1. 

2. 

3. 

4. 

Q.51 Which of the following options is used to search for help topics in MS-Word 2021?

Ans 1. Access 'Help' from the 'View' tab.

2. Go to the 'File' tab and select 'Help'.

3. Click the 'Help' button in the Ribbon.

4. Use the 'Tell me what you want to do' search box.

Q.52 The quadratic equation whose roots are 9 and 11 is:

Ans 1. x2 - 20x + 99 = 0

2. x2 + 20x + 100 = 0

3. x2 - 20x + 98 = 0

4. x2 + 20x - 99 = 0
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Q.53 Which of the following options is NOT used to perform the next animation or advance
to the next slide in MS PowerPoint?

Ans 1. Enter

2. Shift+F5

3. N

4. Page Down

Q.54 Convert binary number 1101.1101 into decimal equivalent.

Ans 1. 12.8125

2. 13.8125

3. 12.625

4. 13.625

Q.55

Ans
1. 

2. 

3. 

4. 

Q.56 What is the formula for the heat produced in a conductor due to the electric current
flowing through it?

Ans 1. H = IR²t

2. H = I²R/t

3. H = IRt

4. H = I²Rt

Q.57 The Mozilla Firefox/Google Chrome/Microsoft Edge requires support for the __________
protocol.

Ans 1. HTTP 2.1

2. HTTP 3.1

3. HTTP 1.1

4. HTTP 1.2

Q.58 Based on the English alphabetical order, three of the following four letter-clusters are
alike in a certain way and thus form a group. Which letter-cluster DOES NOT belong to
that group?
(Note: The odd one out is not based on the number of consonants/vowels or their
position in the letter-cluster.)

Ans 1. EIRV

2. XBIO

3. KOVB

4. AELR
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Q.59 What is the form of the emf produced in thermocouple?
(where Δ t =difference in temperature between the hot thermocouple junction and the
reference junction of the thermocouple and a, b are constants)

Ans
1. 

2. 

3. 

4. 

Q.60 How do you view hidden files and folders in File Explorer in the Windows OS?

Ans 1. Go to 'View' -> Select 'Show hidden items'

2. Right-click -> Select 'View hidden files'

3. Go to 'Settings' -> Select 'Hidden files'

4. Go to 'Edit' -> Select 'Show hidden items'

Q.61 What is the name of the astronaut who was selected for the Axiom-4 mission to the
International Space Station (ISS) in August 2024?

Ans 1. Sharmila Bhattacharya

2. Ashwin Vasavada

3. Kamlesh Lulla

4. Shubhanshu Shukla

Q.62 Select the set in which the numbers are related in the same way as are the numbers of
the following sets.
(NOTE: Operations should be performed on the whole numbers, without breaking down
the numbers into its constituent digits. E.g., 13 – Operations on 13 such as
adding/deleting/multiplying etc. to 13 can be performed. Breaking down 13 into 1 and 3
and then performing mathematical operations on 1 and 3 is not allowed)
(5, 9, 52)
(11, 7, 90)

Ans 1. (7, 13, 98)

2. (14, 4, 63)

3. (8, 11, 95)

4. (9, 6, 65)

Q.63 What does the middle finger represent in Fleming's Left-Hand Rule?

Ans 1. Direction of magnetic field

2. Direction of induced EMF

3. Direction of current

4. Direction of force

Q.64 After Indian Hockey Federation was dismissed in 2008 by IOA, _________ was formed.

Ans 1. Indian Hockey

2. Hockey India

3. Hockey Association

4. National Hockey Federation

Q.65 Which of the following statements regarding the microprocessor 8085 is NOT correct?

Ans 1. 

2. 

3.

4.
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Q.66 What is the function of the 'AutoFit' feature in MS PowerPoint?

Ans 1. Automatically adjusts the size of the text to fit the text box

2. Automatically adds bullet points to text

3. Changes the text colour based on the slide background

4. Aligns text to the centre of the text box

Q.67

Ans 1. D

2. B

3. C

4. A

Q.68 In an AC circuit, if the power factor is 1, it means that ______.

Ans 1. all power is reactive power

2. the circuit is purely resistive

3. the circuit is purely inductive

4. the circuit is purely capacitive

Q.69 In an electric motor, what is the purpose of the commutator?

Ans 1. To increase the motor speed

2. To reverse the direction of current in the armature

3. To decrease the motor speed

4. To supply current to the armature

Q.70 If ‘A’ stands for ‘÷’, ‘B’ stands for ‘×’, ‘C’ stands for ‘+’ and ‘D’ stands for ‘−’, then what
will come in place of the question mark (?) in the following equation?

18 A 6 B 11 C 8 D 6 = ?

Ans 1. 35

2. 33

3. 36

4. 34
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Q.71 What was the unemployment rate (UR) in urban areas as of January – March 2024 for
persons of age 15 years and above?

Ans 1. 67.18%

2. 6.7%

3. 48.35%

4. 53.25%

Q.72 Which option in the Print dialog box allows you to specify the range of pages to print in
Microsoft Word 2010?

Ans 1. Printer

2. Pages

3. Orientation

4. Copies

Q.73 Which of the following terms will replace the question mark (?) in the given series to
make it logically complete?
PU16 QV18 RW22 SX28 ?

Ans 1. TZ36

2. TZ37

3. TY36

4. TY37

Q.74 A car engine generates a force of 10000 N to move the car 1.2 km in 2 minutes. What is
the power of the engine?

Ans 1. 1000 kW

2. 100 kW

3. 10 kW

4. 200 kW

Q.75 When the displacement of a spring is reduced to half its original value, and the spring
constant remains unchanged, what happens to the spring's potential energy?

Ans 1. It decreases to 1/2 of its original value

2. It decreases to 1/4 of its original value

3. It increases to 2 times its original value

4. It remains unchanged

Q.76 The points (-5, 1), (1, k) and (4, -2) are collinear if the value of k is

Ans 1. -1

2. 2

3. 3

4. 1

Q.77 If U = { 1, 2, 3, 4, 5, 6, 7, 8, 9 }, and B = { 2, 4, 6, 8 }, then the number of elements in the
set B′ is:

Ans 1. 5

2. 9

3. 8

4. 4
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Q.78 A and B are two independent events. If P(A) = 0.4 and P(B) = 0.6, then the P(A or B) is
equal to:

Ans 1. 0.66

2. 0.78

3. 0.68

4. 0.76

Q.79 Which menu option allows you to change the height and width of cells in MS-Excel?

Ans 1. Format

2. Review

3. Insert

4. Page Layout

Q.80

Ans 1. 11 : 3

2. 11 : 4

3. 3 : 11

4. 4 : 11

Q.81 A voltmeter has a uniform scale with 100 divisions; the full-scale reading is 300 V and
1/10 of a scale division can be estimated with a fair degree of certainty. Determine the
resolution of the instrument in volt.

Ans 1. 0.1 V

2. 0.5 V

3. 0.2 V

4. 0.3 V

Q.82 The first and last terms of an A.P. are 28 and 31. If the sum of its terms is 236, then the
number of terms will be?

Ans 1. 8

2. 11

3. 6

4. 5

Q.83 Refer to the following letter, number and symbol series and answer the question that
follows.

(Left) 6 2 8 # 7 \ 2 L % 9 3 3 \ / + H 2 $ S P # H (Right)

How many such symbols are there that are immediately preceded by a letter and
immediately followed by a number?

Ans 1. One

2. Two

3. Four

4. Three

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q.84 Six people P, Q, R, S, T and U live on six different floors of the same building. The
bottom-most floor of the building is numbered as 1; the floor above it is numbered as 2
and so on. The topmost floor is numbered as 6.
P lives on an even-numbered floor but not on floor number 4. Only two people live
between S and P. R lives immediately below T. U lives on an even-numbered floor. Q
does not live on the bottom-most floor. How many people live between Q and S?

Ans 1. Three

2. One

3. Four

4. Two

Q.85 How can a user define cell address in an MS Excel sheet?

Ans 1. Column letter plus row number

2. Column letter plus row letter

3. Column number plus row letter

4. Column number plus row number

Q.86 In a school there are 26 teachers who teach mathematics or physics. Of these, 14 teach
mathematics and 6 teach both physics and mathematics. How many teach physics ?

Ans 1. 8

2. 12

3. 10

4. 14

Q.87 In the case of a conservative force, the potential energy _______.

Ans 1. can be defined for any configuration of the system

2. depends on the work done by friction

3. is zero

4. is path dependent

Q.88 A metal rod of length 1.5 m moves with a velocity of 10 m/s through a uniform magnetic
field of 2 T. What is the magnitude of the induced EMF if the rod moves at an angle of
60° to the magnetic field?

Ans 1. 30 volts

2. 36 volts

3. 18 volts

4. 26 volts

Q.89 Which of the following is an ancient Jain text written by Acharya Umaswami that
explains the Jain philosophy in the most systematic form acceptable to all sects of
Jainism?

Ans 1. Svayambhu Stotra

2. Atthapahuda

3. Tattvarthasutra

4. Pravacanasara

Q.90 Which of the following household appliances uses the principle of electromagnetic
induction?

Ans 1. Toaster

2. Refrigerator

3. Electric Fan

4. Electric Iron
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Q.91 Which of the following will NOT produce an induced current in a coil?

Ans 1. Moving the coil towards a stationary magnet

2. Rotating the coil within a magnetic field

3. Increasing the number of turns in the coil while changing the magnetic flux

4. Moving the coil parallel to the magnetic field lines

Q.92 Which of the following correctly describes the most useful biasing conditions of the
emitter-base and base-collector junctions (common base configuration) for a Bipolar
Junction Transistor (BJT) among its different modes of operation?

Ans 1. Active Mode: Emitter-base junction is reverse-biased, and base-collector junction is forward-biased.

2. Active Mode: Emitter-base junction is forward-biased, and base-collector junction is reverse-biased.

3. Cut-off Mode: Both emitter-base and base-collector junctions are forward-biased.

4. Saturation Mode: Both emitter-base and base-collector junctions are reverse-biased.

Q.93 Choose the correct statement related to government expenditure.

Ans 1. Revenue expenditure directly contributes to GDP growth.

2. Revenue expenditure impacts assets liability of the government.

3. Revenue expenditure does not impact assets liability of the government.

4. Capital expenditure directly contributes to GDP growth.

Q.94 Which of the following statements is true about the accuracy of an analog to digital
(A/D) converter?

Ans 1. A dual-slope integrating-type A/D converter has the same accuracy as a single-slope integrating-type A/D converter.

2. A dual-slope integrating-type A/D converter has a very small accuracy than a single-slope integrating-type A/D converter.

3. A dual-slope integrating-type A/D converter has a higher accuracy than a single-slope integrating-type A/D converter.

4. A dual-slope integrating-type A/D converter has a small accuracy than a single-slope integrating-type A/D converter.

Q.95 △ABC is such that AB = 5 cm, BC = 4 cm and CA = 4.5 cm. △XYZ is similar to △ABC. If
YZ = 8 cm, then find the perimeter of △XYZ.

Ans 1. 28 cm

2. 27 cm

3. 26 cm

4. 25 cm

Q.96 The voltage range of resistance-voltage divider is limited to a few:

Ans 1. Micro volts

2. Milli Volts

3. Volts

4. Kilo Volts

Q.97 Match the options from Group A with Group B regarding Auto Fill Options in MS-Excel
sheets.

Group A Group B
1. Copy Cells. I. Copy only the cell formatting
2. Fill Formatting Only II. Copy the entire contents of the cell, including the formulas
and the formatting
3. Fill Without Formatting III. Copy the contents of the cell, including the formulas but
not the formatting

Ans 1. 1-II, 2-III, 3-I

2. 1-III, 2-I, 3-II

3. 1-II, 2-I, 3-III

4. 1-I, 2-II, 3-III
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Q.98 Select the most appropriate option to fill in the blank.
For a given accelerating voltage Ea and for particular dimensions of CRT, the deflection
of the electron beam is _____ to the deflecting voltage.

Ans 1. independent

2. directly proportional

3. inversely proportional

4. square proportional

Q.99 A statement is given followed by two arguments. Decide which of the arguments is/are
strong with respect to the statement.
Statement:
The Government of State A is planning to shut down all markets by 7 pm.
Arguments:
I. Incidents of shoplifting and attempted robberies have increased especially during
night time.
II. Many people get time to shop only after office hours.

Ans 1. Both I and II strengthen the statement.  

2. I weakens while II strengthens the statement. 

3. Both I and II weaken the statement. 

4. II weakens while I strengthens the statement. 

Q.100 What is the purpose of the 'Sleep' option in the Windows OS?

Ans 1. To shut down the system

2. To restart the system

3. To save all open documents and programs while reducing power consumption

4. To delete temporary files
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